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CHAPTER 7: Simulation and Co-simulation with Other Software 

 

7.1. Introduction 

This chapter explores the integration of MATLAB/Simulink with other simulation software 

such as Excel, PSim, PSpice, Proteus, and Scilab. Co-simulation is essential for projects that 

require the combined strengths of multiple software tools to analyze different aspects of a 

system. By leveraging interoperability between different platforms, engineers can perform 

more comprehensive system analyses, benefiting from each tool’s specialized capabilities. 

Upon completing this chapter, you should be able to: 

 Understand the principles and benefits of simulation and co-simulation across 

multiple software environments. 

 Set up and execute co-simulations between MATLAB/Simulink and other software 

tools. 

 Analyze complex systems by integrating simulations from different platforms. 

 Utilize co-simulation techniques to enhance accuracy and expand the scope of 

engineering analyses in power systems, control systems, and other applications. 

 

7.2. Introduction to Microsoft Excel 

Microsoft Excel is one of the most widely used spreadsheet software for data analysis, 

financial management, statistical computations, and more. Its intuitive user interface 

combined with powerful computational capabilities makes it indispensable across various 

academic and professional fields. This section provides a comprehensive overview of Excel's 

key functionalities, including advanced techniques to optimize its use in engineering and 

simulation-related tasks. 

 

7.2.1. Overview of the Excel Interface 

Excel’s interface is designed to enable efficient data management through tables, charts, and 

various visualization tools. The key components include: 

 Ribbon: The menu bar at the top, organizing tools and commands into tabs (File, 

Home, Insert, Formulas, etc.). 

 Worksheet: The main workspace where data is entered and manipulated, structured 

in cells identified by letters (columns) and numbers (rows). 

 Formula Bar: Located beneath the ribbon, this area allows users to input or modify 

formulas. 

 Sheet Tabs: Enable navigation between multiple worksheets within the same 

workbook. 
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Figure 7.1 : Introduction to Microsoft Excel 

 

7.2.2. Basic Data Manipulation 

7.2.2.1. Data Entry and Formatting 

 Data Entry: Entering text, numbers, dates, or formulas in cells. 

 Cell Formatting: Applying specific styles (fonts, colors, borders, alignment, number 

formats). 

 Number Formatting: Customizing the display of numerical data (currency, 

percentage, date, time, etc.). 

 Conditional Formatting: Automatically changing the appearance of cells based on 

specified conditions (e.g., highlighting values above a threshold). 

 

7.2.2.2. Basic Formulas and Functions 

 Arithmetic Operations: 

o Addition and subtraction: =A1 + B1, =A1 - B1 

o Multiplication and division: =A1 * B1, =A1 / B1 

 Common Functions: 

o =SUM(A1:A10): Computes the sum of values in a range. 

o =AVERAGE(A1:A10): Calculates the average of the selected range. 

o =MIN(A1:A10), =MAX(A1:A10): Returns the minimum and maximum values 

in a dataset. 

 

7.2.3. Data Management 

7.2.3.1. Sorting and Filtering Data 
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 Sorting: Arranging data in ascending or descending order based on specified criteria. 

 Filtering: Displaying only data that meets certain conditions, enabling focused 

analysis of specific subsets. 

 

7.2.3.2. Pivot Tables 

Pivot tables are powerful tools that allow users to summarize, analyze, explore, and 

present data dynamically. They facilitate: 

 Grouping data by categories. 

 Calculating totals, averages, and other statistical measures. 

 Creating multi-dimensional reports for business and engineering applications. 

To create a pivot table: 

1. Select the dataset. 

2. Navigate to Insert > PivotTable and configure the fields. 

3. Drag and drop fields into rows, columns, values, and filters to structure the analysis. 

 

7.2.4. Data Visualization 

7.2.4.1. Creating Charts 

 Common Chart Types: Bar charts, line graphs, pie charts, scatter plots, etc. 

 Insertion: Select the data and choose the appropriate chart type from the Insert tab. 

 Customization: Adjust titles, legends, colors, and axes to enhance readability. 

 

7.2.4.2. Advanced Charts 

 Combination Charts: Merging multiple chart types for better data representation. 

 Sparklines: Small embedded graphs within cells for quick trend analysis. 

 

7.2.5. Automating Tasks in Excel 

7.2.5.1. Using Macros 

Macros automate repetitive tasks by recording a sequence of actions that can be executed 

with a single command. 

 Creating a Macro: Navigate to View > Macros > Record Macro and perform the 

desired actions. 

 Running a Macro: Once recorded, it can be executed anytime to repeat the process 

automatically. 

 

7.2.5.2. Introduction to VBA (Visual Basic for Applications) 
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VBA is Excel's programming language, allowing users to develop custom macros and 

automate complex tasks. 

 Accessing the VBA Environment: Press Alt + F11 to open the VBA Editor. 

 Applications: 

o Looping through datasets for data processing. 

o Automating interactions between multiple workbooks. 

o Building simple user interfaces for enhanced usability. 

 

7.2.6. Collaboration and Sharing 

7.2.6.1. Tracking Changes 

 Revision Tracking: Monitors modifications made by multiple users in a shared 

workbook. 

 Comments & Annotations: Facilitates teamwork through embedded notes. 

7.2.6.2. File Sharing 

 Cloud-Based Collaboration: Utilize OneDrive to enable real-time collaborative 

editing. 

 File Protection: Implement passwords or restricted access to safeguard sensitive 

data. 

 

7.2.7. Advanced Techniques 

7.2.7.1. Scenario Analysis 

Scenario analysis tests different hypotheses by adjusting input values and observing 

their impact on results. 

 Scenario Manager: Allows users to create and compare different data scenarios. 

 Data Tables: Analyze how varying one or two input variables influences outcomes. 

 

7.2.7.2. Solver Optimization Tool 

The Solver tool finds optimal solutions for decision-making problems by adjusting multiple 

variables while respecting predefined constraints. 

 Usage: Define an objective function, specify decision variables, set constraints, and 

let Solver determine the best solution. 

 

7.2.8. Practical Examples with Excel 

7.2.8.1. Data Entry and Formatting 

Example: Monthly Expense Tracking 



Chapter 7:         Simulation and Co-simulation with Other Software 

Cours : Logiciels de simulation      - 154 -        Dr. Ali Abderrazak TADJEDDINE 

 

 You can create a table in Excel to track monthly expenses, where each row 

represents an expense and columns include date, category (e.g., food, transport, 

entertainment), amount, and notes if needed. 

 Formatting: The "Amount" column can be formatted in currency format, and 

conditional formatting can be applied to highlight expenses exceeding a certain 

threshold (e.g., amounts greater than 10,000 DZD). 

 

7.2.8.2. Basic Formulas 

Example: Exam Result Calculation 

 Suppose you have a list of students with their grades in different subjects. You can 

use the formula =AVERAGE(B2:E2) to calculate the average score for each student. 

 You can also use =IF(B2>=10, "Pass", "Fail") to determine whether a student passes 

or fails based on their final grade. 

 

7.2.8.3. Pivot Tables 

Example: Business Sales Analysis 

 Imagine you have an Excel sheet containing sales data over several months, with 

columns for product, region, month, and sales amount. 

 You can create a pivot table to summarize total sales by region or product. Filters 

can also be added to analyze sales within a specific time period. 

 

7.2.8.4. Creating Charts 

Example: Student Performance Visualization 

 Suppose you have a table showing students' average grades across multiple subjects. 

You can insert a bar chart to compare student performance. 

 For a more detailed analysis, you can create a combined chart that includes bars 

for individual scores and a line for the class-wide average. 

 

7.2.8.5. Task Automation with Macros 

Example: Automatic Monthly Report Generation 

 If you frequently generate similar reports (e.g., financial reports, sales reports), you 

can record a macro to automate data extraction, formatting, and exporting. 

 For instance, a macro could copy data from one sheet to another, apply necessary 

formatting, and then save the file with a date-based filename. 
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7.2.8.6. Optimization with Solver 

Example: Production Optimization 

 Suppose you manage a manufacturing plant and need to maximize profits by 

deciding how many units of each product to produce while considering constraints 

on labor, materials, and production time. 

 The Solver tool can be used to adjust production quantities to maximize profit 

while ensuring all constraints are met. 

 

7.2.8.7. File Sharing and Collaboration 

Example: Collaborative Project Management 

 If you are working in a team, you can share an Excel file via OneDrive. Team 

members can edit in real time, add comments for better collaboration, and use 

version tracking to monitor changes made by others. 

 

7.2.9. Integration with MATLAB 

Integrating MATLAB with Excel offers several benefits, including data exchange, joint 

analysis, automation, and dynamic interaction. 

 

7.2.9.1. Data Import/Export 

 From MATLAB to Excel: MATLAB can export data directly to Excel files (.xls, .xlsx) 

using functions such as xlswrite or writematrix, allowing the transfer of simulation 

results or analyses for easier presentation or sharing. 

 From Excel to MATLAB: MATLAB can import data from Excel using xlsread or 

readmatrix, making it possible to leverage pre-existing data for further analysis. 

 

7.2.9.2. Joint Data Analysis 

 Preprocessing and Visualization in Excel: Users can clean, organize, and 

visualize data in Excel before importing it into MATLAB for more advanced 

analysis. 

 Post-Processing and Reporting in Excel: MATLAB-generated analysis results can 

be exported to Excel for final formatting, presentation, or report generation. 

 

7.2.9.3. Automation 

 Excel Macros and MATLAB Scripts: Excel macros can trigger MATLAB scripts, or 

vice versa, to automate processes requiring both tools, enhancing workflow 

efficiency. 
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7.2.9.4. Dynamic Interaction 

 MATLAB can interact dynamically with Excel using the Component Object Model 

(COM) API, enabling MATLAB to control Excel for complex tasks such as 

automated report generation, data processing, or real-time updates. 

 

 

7.2.10. Practical Examples of Excel-MATLAB Integration 

These examples demonstrate how Excel and MATLAB can be used together to solve complex 

problems across various applications. By leveraging their respective strengths in data 

management, modeling, simulation, and optimization, users can enhance their workflow 

efficiency. In electrical engineering, integrating Microsoft Excel with MATLAB is particularly 

useful for circuit analysis, power system modeling, and performance optimization of 

electrical equipment. 

 

7.2.10.1. Sensor Data Analysis 

Context: You are working on an engineering project where environmental sensors 

record temperature, humidity, and other data, initially stored in an Excel file. 

 Step 1: Import Data into MATLAB 

The sensor data stored in an Excel file is imported into MATLAB for processing and 

analysis. 

Matlab 

1. sensor_data = readmatrix('sensor_data.xlsx'); 

 

 Step 2: Data Processing 

Apply filtering, statistical analysis, or signal processing algorithms to extract 

meaningful insights from raw data. 

Matlab 

2. filtered_data = lowpass(sensor_data, 0.1); 

 

 Step 3: Visualization of Results 

 Create plots in MATLAB to visualize the processed data, such as temperature trends 

over time. 

Matlab 

3. plot(filtered_data); 

4. title('Filtered Temperature Data'); 
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 Step 4: Export to Excel 

The processed results are exported back to Excel for reporting or further analysis. 

Matlab 

1. writematrix(filtered_data, 'filtered_sensor_data.xlsx'); 

 

7.2.10.2. Using Solver and MATLAB for Optimization 

Context: You are working on factory process optimization using linear optimization 

models. 

 Step 1: Model Creation in Excel 

Define a production cost model in Excel, specifying constraints and decision 

variables in a spreadsheet. 

 Step 2: MATLAB Optimization 

MATLAB is used to solve optimization equations or run complex simulations 

beyond Excel's capabilities. 

Matlab 

1. f = @(x) x(1)^2 + x(2)^2; % Objective function example   

2. x0 = [1, 2];   

3. options = optimset('Display','iter');   

4. [x, fval] = fminsearch(f, x0, options); 

 

 Step 3: Integration with Excel Solver 

The solutions obtained via MATLAB are imported back into Excel, where the Excel 

Solver can verify or refine results. 

Matlab 

1. writematrix(x, 'optimization_results.xlsx'); 

 

 Step 4: Report Generation 

Combine MATLAB's results with Excel-generated solutions to create a detailed 

report on potential cost savings or performance improvements. 

 

7.2.10.3. Excel-Simulink Coupling 

Context: You are simulating a dynamic system, such as a motor control system. 

 Step 1: Define Input Data in Excel 

System parameters, such as transfer coefficients and PID gains, are initially 

stored in an Excel file. 
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 Step 2: Import into MATLAB/Simulink 

MATLAB reads these parameters and applies them to a Simulink model for 

simulation. 

Matlab 

1. params = readmatrix('system_params.xlsx');   

2. assignin('base', 'Kp', params(1));   

 

 Step 3: Simulink Simulation 

Run the motor control system simulation using imported parameters. 

Matlab 

1. sim('motor_control_model');   

 

 Step 4: Export Simulation Results 

The simulation results are analyzed in MATLAB and exported to Excel for further 

study. 

Matlab 

1. writematrix(simout, 'simulation_results.xlsx');   

 

7.2.10.4. Calculating Parameters of an RLC Circuit 

Context: You need to analyze an RLC (Resistor, Inductor, Capacitor) circuit, computing 

resonance, impedance, and other key parameters. 

 Step 1: Store Data in Excel 

Component values (R, L, C) are stored in an Excel file, where each column represents 

a different parameter. 

 Step 2: Import Data into MATLAB 

MATLAB imports these values for analytical calculations. 

Matlab 

1. components = readmatrix('RLC_circuit.xlsx');   

2. R = components(1);   

3. L = components(2);   

4. C = components(3);   

 Step 3: Parameter Calculation 

MATLAB computes the resonance frequency, total impedance, and other circuit 

characteristics. 

Matlab 

1. omega = 1 / sqrt(L * C); % Resonance frequency   

2. Z = sqrt(R^2 + (omega*L - 1/(omega*C))^2); % Total impedance   
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 Step 4: Export to Excel 

The results are stored in Excel for documentation or further analysis. 

Matlab 

1. writematrix([omega, Z], 'RLC_results.xlsx');   

 

7.2.10.5. Optimization of Power Distribution Networks 

Context: You are designing a power distribution network and need to optimize load 

distribution to minimize power losses. 

 Step 1: Network Model in Excel 

Network data, including loads, transmission line lengths, and resistances, are 

initially stored in an Excel spreadsheet. 

 Step 2: Import into MATLAB 

MATLAB reads the network data for further analysis. 

Matlab 

2. network_data = readmatrix('distribution_network.xlsx');   

 Step 3: Simulation and Optimization 

MATLAB simulates network behavior and optimizes load distribution using 

optimization algorithms. 

Matlab 

1. % Example: Cost function to minimize power losses   

2. cost = @(x) sum((network_data(:,3) .* x).^2 ./ network_data(:,2));   

3. options = optimset('Display','iter');   

4. optimal_loads = fminsearch(cost, initial_loads, options);   

 

 Step 4: Export Optimized Results 

The optimized results are exported back to Excel for validation or further analysis. 

Matlab 

1. writematrix(optimal_loads, 'optimized_loads.xlsx');   

 

7.2.10.6. Renewable Energy System Simulation 

Context: You are simulating a photovoltaic (PV) system and analyzing its performance 

based on weather conditions. 

 Step 1: Store Meteorological Data in Excel 

Weather data (irradiance, temperature) for a specific period is recorded in an Excel 

file. 
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 Step 2: Import into MATLAB 

 MATLAB reads the weather data to perform a dynamic simulation. 

Matlab 

1. weather_data = readmatrix('weather_data.xlsx');   

2. irradiance = weather_data(:,1);   

3. temperature = weather_data(:,2);   

 

 Step 3: Simulate PV System Performance 

MATLAB models the PV system output based on weather conditions. 

Matlab 

1. % Simple PV output model based on irradiance and temperature   

2. P_out = irradiance .* (1 - 0.0045 * (temperature - 25)) * P_max;   

 

 Step 4: Export Results to Excel 

The simulation results, such as energy production over time, are stored in Excel 

for further analysis. 

Matlab 

1. writematrix(P_out, 'pv_performance.xlsx');   

 

7.2.10.7. Harmonic Analysis in an Electrical System: FFT Analysis 

Context: 

You need to analyze harmonics present in an electrical system to assess power quality. 

 Step 1: Collecting Voltage/Current Data in Excel 

o Voltage or current measurements at different points in the system are 

recorded in an Excel file. 

 Step 2: Importing Data into MATLAB 

o Import the Excel data into MATLAB to perform a Fast Fourier Transform 

(FFT) analysis. 

Matlab 

1. signal_data = readmatrix('harmonic_data.xlsx'); 

 

 Step 3: FFT Analysis 

o Use MATLAB to perform an FFT analysis on the signals to identify harmonic 

components and their amplitudes. 

Matlab 

2. fft_result = fft(signal_data); 

3. frequencies = (0:length(fft_result)-1) * (sampling_rate/length(fft_result)); 
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 Step 4: Visualization and Export to Excel 

o The FFT analysis results, including harmonic frequencies and their 

amplitudes, are visualized in MATLAB and exported to Excel for 

documentation or presentation. 

Matlab 

1. writematrix([frequencies', abs(fft_result)], 'harmonic_analysis.xlsx'); 

 

7.3. Practical Examples of PSim-MATLAB Co-Simulation 

PSim is a specialized simulation software for power electronics, which can be integrated with 

MATLAB/Simulink for co-simulations. This integration is particularly beneficial for systems 

where both power electronics and control strategies are critical. MATLAB/Simulink is used 

to model and simulate complex control algorithms, while PSim focuses on the accurate 

simulation of power circuits. 

 

Figure 7.2 : PSIM Environment 

 

7.3.1. Co-Simulation of a DC-DC Converter with PID Control 

Context: You are designing a Buck converter for a power supply application, where precise 

voltage regulation is required. A PID controller is used to maintain a stable output voltage 

despite load variations or input voltage fluctuations. 

 Step 1: Use MATLAB/Simulink to model the PID controller, defining the 

proportional, integral, and derivative gains in Simulink. 

 Step 2: Simulate the Buck converter circuit in PSim, including MOSFETs, diodes, 

inductors, and capacitors. 
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 Step 3: Establish a co-simulation interface between MATLAB/Simulink and PSim, 

enabling MATLAB to control the Buck converter model in PSim in real-time. 

 Result: The system’s response to load variations can be observed, and PID 

parameters can be adjusted in MATLAB for optimal performance. Co-simulation 

allows simultaneous evaluation of control effectiveness and power losses, 

enhancing design accuracy. 

 

7.3.2. Simulation of a Buck Converter 

 Context: You need to design and analyze a Buck converter to step down an input 

voltage of 24V to 12V with a 10-ohm load. 

 Implementation: 

o Model the Buck converter using PSim components (MOSFET, diode, 

inductor, capacitor). 

o Set up the circuit parameters and run the simulation to observe the output 

voltage waveform and inductor current. 

 Results Analysis: 

o Use PSim measurement tools to verify the output voltage, switching 

losses, and efficiency of the converter. 

 

7.3.3. PID Controller Modeling for a DC Motor 

 Context: You want to implement a PID controller to regulate the speed of a DC 

motor. 

 Implementation: 

o Use PSim to model the DC motor and integrate a PID controller in the 

feedback loop. 

o Tune the PID parameters to achieve an optimal speed response. 

 Simulation and Results: 

o Run the simulation and observe the frequency response, system stability, 

and transient response under various load conditions. 

 

7.4. Practical Examples of PSpice-MATLAB Integration 

PSpice is a powerful tool for simulating electronic circuits, particularly for analog signal 

analysis. Once a PSpice simulation is completed, results can be exported to MATLAB for 

further processing, statistical analysis, and advanced visualization. 
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Figure 7.3 : PSpice interface 

 

7.4.1. FFT Analysis of an Amplifier Simulation 

Context: You are designing an operational amplifier and need to analyze its output frequency 

spectrum to detect undesirable harmonics. 

 Step 1: Design and simulate the amplifier circuit in PSpice, running a transient 

analysis to capture the output signal over time. 

 Step 2: Export the simulation results (time-domain signal) as a text or CSV file. 

 Step 3: Import the data into MATLAB to perform an FFT (Fast Fourier Transform) 

analysis. MATLAB processes the data and visualizes the frequency spectrum. 

 Result: 

o The frequency spectrum in MATLAB allows you to identify harmonics 

contributing to distortion. 

o Adjustments can then be made in PSpice, such as modifying passive 

components or tuning amplifier parameters. 

 

7.4.2. AC Analysis of an RC Low-Pass Filter 

 Context: Design and analyze a low-pass RC filter with a 1 kHz cutoff frequency. 

 Implementation: 

o In PSpice, model the RC filter with appropriate resistor and capacitor 

values. 

o Run an AC analysis to plot the frequency response curve. 
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 Results: 

o Verify the cutoff frequency, signal attenuation, and phase response of the 

filter. 

 

7.4.3. Simulation of an Inverting Operational Amplifier 

 Context: Simulate an inverting op-amp configuration with a gain of -10. 

 Implementation: 

o Use PSpice to design the circuit with an op-amp, input resistor, and 

feedback resistor. 

o Run the simulation to observe input signal inversion and amplification. 

 Results Analysis: 

o Measure the gain, bandwidth, and distortion under different input signal 

conditions. 

 

7.5. Practical Examples of Proteus-MATLAB Integration 

Proteus is widely used for simulating electronic circuits, including embedded systems with 

microcontrollers. MATLAB can be used to develop control algorithms, which can then be 

tested in Proteus before being deployed on actual hardware. 

 

Figure 7.4 : Proteus interface 

 

7.5.1. Motor Control Algorithm Development and Testing 

Context: You are developing a motor speed control algorithm using a PIC microcontroller. 

 Step 1: Develop the control algorithm in MATLAB, such as adjusting PWM duty 

cycles based on motor speed. 
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 Step 2: Implement the algorithm in a simulated PIC microcontroller in Proteus. 

o The code is written in C, compiled, and uploaded to the virtual 

microcontroller. 

 Step 3: Simulate the entire system in Proteus, including the microcontroller, 

motor, and speed sensor. 

 Result: 

o Verify if the algorithm correctly regulates motor speed. 

o Observe responses to load variations and setpoint changes before testing 

on real hardware. 

 

7.5.2. Microcontroller-Based LED Control Simulation 

 Context: Develop and test a PIC microcontroller program to control LEDs based 

on sensor input. 

 Implementation: 

o Use Proteus to simulate the PIC microcontroller circuit with LEDs and 

sensors. 

o Write the control code in C, upload it to the simulated PIC, and run the 

simulation. 

 Results: 

o Observe LED behavior based on sensor readings and adjust the code 

accordingly. 

 

7.5.3. Design and Simulation of a Regulated Linear Power Supply 

Context: You aim to design a regulated linear power supply that provides a stable 5V output. 

 Implementation: 

o Model the circuit in Proteus using a voltage regulator (such as the 7805), a 

transformer, rectifier diodes, and filter capacitors. 

o Simulate the circuit to observe the output voltage under different load 

conditions. 

 Results Analysis: 

o Verify the stability of the output voltage. 

o Analyze the noise level and the transient response of the regulator. 
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7.6. Practical Examples of Scilab-MATLAB Integration 

Scilab is a numerical computing environment similar to MATLAB, and both can be used 

together to leverage their respective strengths. Scilab can be utilized for tasks such as 

simulation and optimization, while MATLAB can be used for advanced visualizations, co-

simulation with other tools, and statistical analysis. 

 

Figure 7.5 : Scilab interface 

 

7.6.1. Simulation of a Dynamic System with Cross-Validation 

Context: You are modeling a complex dynamic system, such as a synchronous machine, and 

wish to validate your results by using both Scilab and MATLAB for cross-analysis. 

 Step 1: Model the dynamic system in Scilab, leveraging its built-in libraries to solve 

differential equations and simulate time-domain behavior. 

 Step 2: Export the simulation results (e.g., state variables) from Scilab to MATLAB. 

 Step 3: Use MATLAB for further analysis, such as stability studies using advanced 

control techniques, or to create high-quality visualizations that highlight system 

performance under different operating conditions. 

 Result: 

o By comparing the simulation results from Scilab and MATLAB, you can 

validate the accuracy of your models. 

o Each software environment offers specific tools, and combining them allows 

you to refine your design with higher precision. 
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7.6.2. Solving Differential Equations for an RLC Circuit 

Context: 

You need to solve a differential equation representing a series RLC circuit to analyze its 

time response. 

 Implementation: 

o Use Scilab to define and numerically solve the differential equation 

governing the circuit behavior. 

o Apply the ode function in Scilab to compute the system’s response to a given 

input signal. 

 Results: 

o Plot the time response of the current or voltage in the circuit. 

o Analyze the transient response, including overshoot, settling time, and 

damping characteristics. 

 

7.6.3. Simulation and Visualization of a PID Control System 

Context: 

You want to model and simulate a PID control system for regulating the temperature of 

an industrial furnace. 

 Implementation: 

o In Scilab, model the furnace dynamics and implement a PID controller. 

o Use Scilab's simulation functions to tune the PID parameters and simulate 

the system’s response. 

 Results Analysis: 

o Visualize the temperature response over time. 

o Adjust PID parameters to optimize the controller's performance, reducing 

overshoot and steady-state error. 

 

7.7. Conclusion 

In this final chapter, you explored the integration of MATLAB/SIMULINK with other 

simulation software, including PSim, PSpice, Proteus, and Scilab. You have gained the 

skills to configure and perform co-simulations, leveraging multiple tools to achieve more 

comprehensive system analyses. 

The ability to integrate different simulation platforms is crucial for tackling complex 

engineering challenges, where a single tool may not be sufficient. By mastering co-

simulation techniques, you are now equipped to handle multidisciplinary projects that 

require collaboration between various software environments, ultimately enhancing the 

accuracy and scope of your simulations. 


	CHAPTER 7: Simulation and Co-simulation with Other Software

